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Objectives 
When you complete this workshop you will be able to: 

• Type in MS Word; 
• Perform basic formatting of text; 
• Know font basics; 
• Know how to open, close, and save documents 
 
 

What is Microsoft Word? 
 
Microsoft Word is also called MS Word or just Word. 
We use MS Word to: 
 

� Create new documents 
� Format documents 
� Edit documents 

 
Microsoft Word is: 

• A word processing application 
• A word processing program 
• A word processing package 
• A word processor 

 
All of these mean the same thing. 
 
Each Word document is saved in a file on the computer’s hard drive, or on a diskette 
(floppy disk). If you have 10 documents, then you have 10 files. A document can be very 
short or very long. Even a document with 100 pages can be saved as one file. 

 
Creating a document 
 
Start MS Word 
Step 1: 

Open the Start Menu. 
Step 2: 

Open the Program Menu. 
Step 3: 

Find Microsoft Word on the Program Menu (usually under Microsoft office and left 
 click once.  

  
This is also called “opening the program” or “launching the program.” 
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If there is a shortcut for Microsoft Word on the Desktop, or if you have the Microsoft 
Office Icon on the tool bar you can double-click the Microsoft Icon to open the program. 
 
Typing in MS Word 
 
Text Area                                                                               

 

Just below the ruler is a large area called the "text area." You type your document in the 
text area. The blinking vertical line in the upper left corner of the text area is the cursor. It 
marks the insertion point. As you type, your work will show at the cursor location.  

Here are some basic rules for typing on a computer: 
 

• Hold down the Shift key to get capital (uppercase) letters. Let go of the Shift key 
when you want to go back to small (lowercase) letters. 

 
• Never press the Enter key in middle of a paragraph. The lines will automatically 

go to the next line-unlike a typewriter! 
 

• If you would like a blank line, press the Enter key twice. 
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• Use the Tab key to indent a paragraph. 
 

• Type two spaces after each period (and one space after each word). 
 

• Do not type a small L (l) when you want a number one (1). They are different.  
 

• Notice that your mouse arrow changes into a skinny mouse cursor when it’s 
inside the Word document window. There is also a blinking cursor where you 
are typing. (That is, you may see two cursors.) To move the blinking cursor to a 
different place, you can move the mouse cursor to that place and click once. 

 
• To erase a mistake, you can use the Backspace key. This will erase to the left. 

 
• You can also use the Delete key to erase mistakes. This will erase to the right (the 

opposite of Backspace). 
 

• To move the blinking cursor through out the document without erasing, and 
without making extra spaces, use the four arrow keys (also called cursor keys). 

 
• If you are typing ALL CAPITAL LETTERS, press the Caps Lock key once. Press 

Caps Lock to return to normal text. 
 

• If you are typing and erasing at the same time (that is, your new words are going 
over top of the old words), press the Insert key once.  This lets you insert new text 
without deleting old text.  (This happens only in older versions of MS Word). 

 
Practice 
 

� Type a short description of your life, your childhood, your job, or your 
family (about 100-150 words). While you are typing, you will learn  how 
MS Word works. 

 
� Make at least three separate paragraphs. Press the Enter key once at the 

end of each paragraph. Use the Tab key to indent the beginning of each 
paragraph. If you press Tab twice, use the Backspace key to go back 
(delete the extra tab). 

 
� Practice using the arrow keys and the Backspace key and the Delete key- 

learn how these keys work. 
 

� Practice moving the blinking cursor by placing your mouse cursor 
somewhere and clicking once. Try typing more text in the place where you 
moved the cursor. 
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Saving a document 
It’s always very important to remember where you saved a file and what name you gave 
it. 
                                   ↓ 

 
The Standard Toolbar  

 
Step 1: 

Click the Save button on the Standard toolbar. It is the button in the upper left 
corner looks like a little diskette (floppy disk).  If you do not see this button, open the 
View menu and go to Toolbars.  A sub-menu opens. Select Standard. This will make the 
Standard Toolbar appear. 
 
If this is the first time that you are saving the document, the Save As window will open. 
This is how you choose where to put the file and what name you give to it. This is the 
Save As window: 
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Step 2: 
Choose where to save the file. Use the Save In box to find the folder where you 

want to keep this document. Click the small black triangle (arrow) to get a menu. 
 
Step 3: 

Give your document a name. Type the name inside the File Name box. 
 *When choosing a name avoid spaces, symbols, & etc. 
Step 4: Click the Save button on the right-hand side of the Save As window. This will 
make that window close. Your document is now saved. 
 
Saving your document after the first time: 
After you saved things to your document or make changes, just click the Save button on 
the Standard Toolbar. The button looks like a little diskette floppy disk. 
 
 
Printing a document 
There are two ways to print a document. 
The simplest way is to click the Print button on the Standard Toolbar. 
 
                         ↓ 

 
 
When you do this, the active document (the one you see open) will be printed, if your 
computer is connected to a printer. 
The other way is to open the File menu and click Print. The Print dialog box will open. 
This box gives you the options: 
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• You can choose a different printer. In an office, when computers are on a 
network, you may be connected to more than one printer. Maybe one prints color/ 
maybe another one has extra-large paper. 

• You can choose to print out part of a document. If you made changes only to get 3 
pages from 10 page document, this saves paper; you can print just the 3 pages and 
nothing else.  To do this check the “Pages:” circle and indicate which pages you 
would like to print.  For example from a 10 page document if you type in 5-7 in 
the bar next to “Pages:” pages 5, 6, and 7, will print. 

• You can choose to print more than one copy. 

 
If you want one or more copies of all the pages of the document select the number of 
copies under “Number of copies:’, then click the Print button. 
 
Print Preview 
On the file menu, click Print Preview. This will show you exactly what the document will 
look like after it’s printed. You don’t need to do this with simple documents. 
Later, when you add headings, graphics, or headers and footers, you will want to check to 
see how it looks before you print. 
 
The simplest way is to click on the Print Preview button on the Standard toolbar. 
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Practice: 
• Open the document that you have created. 
• Open the File menu and click Print Preview. 
• Use the scroll bar on the right to see each one of three pages. 
• Use the magnifying glass to see a full size page. Your cursor will change to the 

magnifying glass when you move it onto the page. Click once to make three print 
full size. Click again to make it small and see the whole page at once. 

• Click the button labeled Close to close the Print Preview window and return to the 
regular document. NOTE: This is not the normal Close button (the little X)-it says 
Close. 

 
Closing a document 
After you save a document, it is still open on your screen. To put it away, you must close 
the document. 
Step 1: 

Open the File menu. 
Step 2: 

Click Close. (The document goes away.) 
 
Practice: 

• Save your story. Make sure you notice where you’re saving it. Also make sure 
you name the file. 

• Write down the file name and the folder where you saved it (so you don’t forget). 
• Add some words to your story. Save it again. 
• Close the document. 
 
 

Editing a document 
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 Opening a document 
 
          ↓ 

 
 

1: Open the file menu and click Open. The Open dialog box will appear (see above). 
2: If you see the file you want in the large white part of this window, double click the      

file’s icon. That will open the document in MS Word 
3: If you don’t see the file that you want, you need to look in a different folder. 

 
The Look In box at the top of the window shows which folder you are looking in. If you 
need to look in a different folder, click the small black triangle (arrow) on the right-hand 
side of the Look In box. 
 
Use the list to find the right folder.  For example, if you double click (C:) on this list, you 
will see all the folders on the C:/ drive. Then double click the folder you need, and you 
will see all the files inside that folder. 
 
Tip: Some files are listed on the File menu, at the bottom. If you want to open your 
document fast, look on the File menu first. These files are the ones opened most recently. 
If you have not opened your document in a few days, you will not see it on this list. 
 
 
 
Practice: 
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• Open the document that you saved before. (If you can’t find it, use File and the 
Start menu. Notice what folder it’s in. Then go back to MS Word and try to open 
it using the Open dialog box). 

• Close the document. 
• Use the File menu to open the same document. It doesn’t need to be the one that 

you wrote. 
• Close the second document. Notice that the first one that you opened is still there. 
• Close the first document. 
• Practice using the Look In box on the Open dialog box.  

 
To Insert Symbols 

1. Choose Insert in the menu bar. 
                                 ↓ 

 
 
2. Click on Symbol. Look for the symbol of your choice 
3. Click insert for as many symbols as you would like  
4. Click Close. 
 

Practice: 
1. Create a new document. Double space and center document both horizontally and 

vertically. 
2. Type the following lines as shown below, inserting the check marks and 

diamonds as needed. (For a check mark use the symbol font and for the diamond 
use monotype sorts. 

 
 � � � � 

 
Selecting block of text 
First you need to highlight the text you want to format. 
There are three ways to select text. All three ways use the mouse: 

1. Double click to select one word (the word the cursor is on). Triple click to select 
the whole paragraph 

2. Click to drag: Put the mouse cursor where you want to start. Click the mouse 
button and hold it down, then drag to where you want it to end. Let go the mouse 
button. 

3. Point and click: Put the mouse cursor to the far left of the line, but stay inside the 
white Word document window. When the mouse cursor changes to a fat white 
arrow, click once. This defines one full line of text. If you want to select more 
than one line, click and hold the mouse button, then drag down. 
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Cut, Copy and Paste Text 
 

 
 
These three functions are used a lot-not only in MS Word, but in may other Windows 
applications as well.In Microsoft Word, you can cut (delete) text from one area of the 
document and save that text so it can be pasted elsewhere in the document. When you cut 
text, it is stored on the Clipboard. Information stored on the Clipboard stays there until 
new information is either cut or copied. Each time you execute Cut or Copy, you replace 
the old information on the Clipboard with whatever you just cut or copied. You can paste 
Clipboard information as often as you like.  

To Cut - Using the Menu Bar 

1.Type the following:  
I want to move.  I am content where I am.  

2.Highlight "I want to move."  
3.Click on Edit.  
4.Highlight Cut. Click on this and press enter.  
5.Your text should now read:  

"I am content where I am." 

To Paste - Using the Menu Bar 

1.Place the cursor after the period in the sentence "I am content where I am."  
2.Press the Spacebar to leave a space.  
3.Click on Edit.  
4.Highlight Paste. Click on this and the press enter.  
5.Your text should now read.  

"I am content where I am. I  want to move." 

Alternate Method -- Cut by Using the Icon  

1. Type the following:  
I want to move.  I am content where I am.  

2. Highlight "I want to move."  

3. Click on the Cut icon .  
4. Your text should now read.  
5. "I am content where I am."  

Alternate Method -- Paste by Using the Icon  
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1. Place the cursor after the period in the sentence  
"I am content where I am."  

2. Press the Spacebar to leave a space.  

3. Click on the Paste icon .  
4. Your text should now read.  
5. "I am content where I am. I  want to move."  

Alternate Method -- Cut by Using Keys  

1. Type the following:  
I want to move.  I am content where I am.  

2. Highlight "I want to move."  
3. Press Ctrl-x.  
4. Your text should now read.  
5. "I am content where I am."  

Alternate Method -- Paste by Using Keys  

1. Place the cursor after the period in the sentence: "I am content where I 
am."  

2. Press the Spacebar to leave a space.  
3. Press Ctrl-v.  
4. Your text should now read.  
5. "I am content where I am. I  want to move."  

Copy and Paste 
In Microsoft Word, you can copy text from one area of the document and place that text 
elsewhere in the document.  As with cut data, copied data is stored on the Clipboard.  
 
Copy - Using the Menu  

1. Type the following:  
You will want to copy me.  One of me is all you need.  

2. Highlight "You will want to copy me."  
3. Click on Edit.  
4. Highlight Copy. Press Enter.  

Paste  - Using the Menu  

1. Place the cursor after the period in the sentence: "One of me is all 
you need."  

2. Press the Spacebar to leave a space.  
3. Click on Edit.  
4. Highlight Paste. Press Enter.  
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5. Your text should now read:  
"You will want to copy me.  One of me is all you need.  You will 
want to copy me." 

 
Alternate Method -- Copy by Using the Icon  

1. Type the following:  
You will want to copy me.  One of me is all you need.  

2. Highlight "You will want to copy me."  

3. Click on the Copy icon  .  

Alternate Method -- Paste by Using the Icon  

1. Place the cursor after the period in the sentence: "One of me is all 
you need."  

2. Press the Spacebar to leave a space.  

3. Click on the Paste icon .  
4. Your text should now read:  
5. "You will want to copy me. One of me is all you need. You will 

want to copy me."  

Alternate Method -- Copy by Using Keys  

1. Type the following:  
You will want to copy me.  One of me is all you need.  

2. Highlight "You will want to copy me."  
3. Press Ctrl-c.  

Alternate Method -- Paste by Using Keys  

1. Place the cursor after the period in the sentence "One of me is all 
you need."  

2. Press the Spacebar to leave a space.  
3. Press Ctrl-v.  
4. Your text should now read:  
5. "You will want to copy me.  One of me is all you need.  You will 

want to copy me."  

Undo and Redo 
You can quickly undo most commands you execute by using Undo. If you then change 
your mind, you can use Redo.  
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1. Type Undo example.  
2. Click on Edit.  
3. Highlight Undo Typing.  Click on this or press Enter.  
4. The typing should disappear.  
5. Click on Edit.  
6. Highlight Redo Typing. Click on this or press Enter.  
7. The typing should reappear.  
8. Highlight "Undo example."  
9. Press Ctrl-b to bold.  
10. Click on Edit.  
11. Highlight Undo Bold. Click on this or press Enter.  
12. The bolding should be removed.  
13. Click on Edit.  
14. Highlight Redo Bold. Click on this or press Enter.  
15. Your text should be bold again.  

Undo & Redo by Using Keys  
1. Type: Undo example.  
2. Press Ctrl-z.  The typing should disappear.  
3. Press Ctrl-y.  The typing should reappear.  
4. Highlight "Undo example."  
5. Press Ctrl-u to underline.  
6. Press Ctrl-z.  The underline should be removed.  
7. Press Ctrl-y.  The underline should reappear.  

Basic formatting of text  
 

 
The Formatting Toolbar 
Boldface, italics, and underlying are done with three buttons on the Formatting Toolbar 
near the top of the Word program window. They look like: 
 

 
 

1. Select the text you want to format. 
2. Click the button for the kind of formatting you want : B= bold, I=italics, 

U=underlined 
 
If you do not see these buttons, open the View menu and go to Toolbar s. A sub-menu 
opens. Select Formatting. This will make Formatting toolbar appear. 
 
Practice: 
-Select one word in your story and make it bold. 
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-Select one word in your paragraph and make it italic. 
-Select two words side by side in the italic paragraph. Make them bold. (they will be bold 
 and italic.) 
-Select one complete sentence and make it underlined. 
-Select one word in the underlined sentence. Click on the underline button in the toolbar. 
 (The underlining should go away for the selected word.) 
-Experiment with taking away the underlining, boldface, and italics. 
 
Experiment with combining these formats.  Make a sentence both italics and underlined, 
or all three: bold, italic and underlined. 
 
 
Font Size  
In Microsoft Word, you can change the size of your font (text). The following exercise 
illustrates changing the font size.  

Change Font Size - Using the Menu  

1. Type the following:  
I am the smallest.  I am a little bigger.  I am the biggest.  

2. Highlight "I am the smallest."  
3. Click on Format.  
4. Highlight Font.  Click on this or press Enter.  
5. Click on the Font tab, if it is not in the front.  
6. Type 8 in the Size field, or click on 8 in the box below the Size 

field.  
7. Click on OK.  
8. Highlight "I am a little bigger."  
9. Click on Format.  
10. Highlight Font.  Click on this or press Enter.  
11. Click on the Font tab, if it is not in the front.  
12. Type 14 in the Size field, or click on 14 in the box below the Size 

field.  
13. Click on OK.  
14. Highlight "I am a the biggest."  
15. Click on Format.  
16. Highlight Font.  Click on this or press Enter.  
17. Click on the Font tab, if it is not in the front.  
18. Type 24 in the Size field, or click on 24 in the box below the Size 

field.  
19. Click on OK.  
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20. Your text should now look similar to the following:  

"I am the smallest. I am a little bigger. I am the 
biggest." 

Alternate Method -- Change Font Size by Using the Toolbar  

 

1. Highlight:  
"I am the smallest. I am a little bigger. I am the biggest."  

2. Press Ctrl-Spacebar to set the formatting back to the default.  
3. Highlight "I am the smallest."  

4. In the Font Size box  on the Tool Bar, type 8.  
5. Press Enter.  
6. Highlight "I am a little bigger."  

7. In the Font Size box  on the Tool Bar, type 14.  
8. Press Enter.  
9. Highlight "I am a the biggest."  

10. In the Font Size box  on the Tool Bar, type 24.  
11. Press Enter.  

Fonts  
In Microsoft Word, you can change the font (the "family" of type you use for your text). 
This feature is illustrated in the following exercise:  
 
Change the Font - Using the Menu  

1. Type the following:  
Arial Courier Times New Roman  

2. Highlight "Arial."  
3. Click on Format.  
4. Highlight Font.  Click on this or press Enter.  
5. Click on the Font tab, if it is not in the front.  
6. In the box below the Font field, click on "Arial."  
7. Click on OK.  
8. Highlight "Courier."  
9. Click on Format.  
10. Highlight Font.  Click on this or press Enter.  
11. Click on the Font tab, if it is not in the front.  
12. In the box below the Font field, click on "Courier."  
13. Click on OK.  
14. Highlight "Times New Roman."  
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15. Click on Format.  
16. Highlight Font.  Click this or press Enter.  
17. Click on the Font tab, if it is not in the front.  
18. In the box below the Font field, click on "Times New Roman."  
19. Click on OK.  
20. Your text should now look similar to the following:  

"Arial Courier Times New Roman" 

Alternate Method -- Change the Font by Using the Formatting Toolbar  

 

1. Highlight "Arial Courier Times New Roman."  
2. Press Ctrl-Spacebar. Ctrl-Spacebar sets the formatting back to the 

default.  
3. Highlight "Arial."  

4. Click to open the Font pull-down menu  on 
the Formatting toolbar.  

5. Click on "Arial."  
6. Next, highlight "Courier."  

7. Click to open the Font pull-down menu on 
the Formatting toolbar.  

8. Click on "Courier."  
9. Next, highlight "Times New Roman."  

10. Click to open the Font pull-down menu on 
the Formatting toolbar.  

11. Click on "Times New Roman."  
12. Your text should now look similar to the following:  
13. "Arial Courier Times New Roman"  

Highlighting Text  
Highlighting by Using the F8 (or Shift) and Arrow Keys 
*F8 and Shift are interchangeable in this case.  Shift must stay pressed while you 
highlight while the F8 key does not.  

1. Place the cursor before or after the text you wish to highlight and 
click the left mouse button.  

2. Press the F8 key (or Shift), which will serve as an "anchor" 
showing where text you wish to highlight begins or ends.  

3. Press the appropriate arrow key (left arrow to move to the left, or 
right arrow to move to the right) until the text is highlighted. You 
can use the up or down arrow key to highlight one line at a time. 
Press Esc to remove the anchor.  
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Highlighting by Using the Mouse  

1. Place the cursor before or after the text you wish to highlight.  
2. Hold down the left mouse button.  
3. Move the mouse left, right, up, or down until the text is 

highlighted.  

Paragraph formatting 
Line Spacing  

Line Spacing sets the amount of space between lines within a paragraph. Single spacing 
is the default. The spacing for each line is set to accommodate the largest font on that 
line. If there are smaller fonts on the line, there will appear to be extra space between 
lines where the smaller fonts are located. At 1.5 lines, the Line Spacing is set to one-and-
a-half times the single-space amount.  For double-spaced lines, the line spacing is set to 
two times the single-space amount.  

 

 

Practice: 
1. Highlight the first paragraph you typed.  
2. Click on Format.  
3. Highlight and click on Paragraph. Press Enter.  
4. Click on the Indents and Spacing tab, if that tab is not in the front.  
5. Click to open the drop-down menu on the Line Spacing field.  
6. Click on 1.5 Lines.  
7. Click on OK.  
8. Your line spacing for the paragraph should now be 1.5.  

First-Line Indent  
This exercise will demonstrate how you can indent the left side of the first line of your 
paragraph, as in the following example.  
Example -- First-line Indent  

      The first-line indent feature indents the first line of the paragraph. The 
amount of the indent is specified in the By field. The remainder of the 
paragraph is indented by the amount specified in the Indentation field. 

Practice: 
1. Highlight the second paragraph you typed. 
2. Click on Format.  
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3. Highlight and click on Paragraph. Press Enter.  
4. Click on the Indents and Spacing tab, if that tab is not in the front.  
5. Click to open the drop-down menu on the Special field.  
6. Click on First Line.  
7. Enter 0.25" in the By field.  
8. Click on OK.  
9. The first line of your paragraph should now be indented .25 inches.  

Special Note: To remove the first line indent:  

1. Place the cursor anywhere in the paragraph.  
2. Click on Format.  
3. Highlight Paragraph. Press Enter.  
4. Click on the Indents and Spacing tab, if that tab is not in the front.  
5. Click in the Special pull-down menu; then click on None.  
6. Click on OK.  

 
 
Indentation  
Indentation allows you to indent your paragraph from the left or right margin.  The 
following examples show different types of indentation.  
Example -- Indentation  

We will use this paragraph to illustrate several Word features.  It will be 
used to illustrate Space Before, Space After, and Line Spacing.  Space 
Before tells Word how much space to leave before the paragraph.  Space 
After tells Word how much space to leave after the paragraph.  Line 
Spacing sets the space between each line within a paragraph. 

We will use this paragraph to illustrate some additional 
Word features.  It will be used to illustrate first-line indent. 
With first-line indent, you can indent the first line of your 
paragraph.  We will also look at Indentation. Indentation 
enables you to indent from the left or right margins of your 
document.  

Practice: 
1. Highlight the second paragraph, beginning with "We will use" and 

ending with "of your document."  
2. Click on Format.  
3. Highlight Paragraph. Press Enter.  
4. Type 1" in the Left field.  
5. Type 1" in the Right field.  
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6. Click on OK.  
7. Your paragraph should now be indented one inch from both the 

left and right margins, as in the example.  

Alignment  
Microsoft Word gives you a choice of several types of alignment.  Left-justified text is 
aligned on the left side.  It is the default setting.  
                                                                          � 

 
 
Most documents are left- aligned (or left-justified).  Sometimes a title is centered. 
 
Alignment works on the whole paragraph.  If you want to center just one word, you must 
put that word on a line by itself (use the Enter key). 
 
In addition to the toolbars you can also use the menu bar to access the formatting tools. 
 
Example -- Left-Justified  

Sample Paragraph  

This is a sample paragraph.  It is used to illustrate alignment.  Left-
justified text is aligned on the left.  Right-justified text is aligned on the 
right. Centered text is centered between the left and right margins.  You 
can use Center to center your titles.  Justified text is flush on both sides.  

 
 
 
 
Right-justified text is aligned on the right side.  
Example -- Right-Justified  

Sample Paragraph  

This is a sample paragraph.  It is used to illustrate alignment.  Left-
justified text is aligned on the left.  Right-justified text is aligned with on 

the right.  Centered text is centered between the left and right margins. 
You can use Center to center your titles.  Justified text is flush on both 

sides.  

Centered text is centered between the left and right margins.  
Example -- Centered  
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Sample Paragraph  

This is a sample paragraph. It is used to illustrate alignment. Left-justified 
text is aligned on the left. Right-justified text is aligned with on the right. 
Centered text is centered between the left and right margins. You can use 

Center to center your titles. Justified text is flush on both sides.  

Justified text is flush on both sides.  
Example -- Justified  

 
The following exercises demonstrate how to justify text.  
 
Right Justify  

1. Return to the first paragraph you typed, beginning with "We will 
use" and ending with "within a paragraph."  Highlight the 
paragraph.  

2. Click on Format.  
3. Highlight Paragraph.  Click on this or press Enter.  
4. Click on the Indents and Spacing tab, if that tab is not in the front.  
5. Click to open the Alignment pull-down menu.  
6. Click on Right.  
7. Click on OK.  
8. The paragraph should now be right-aligned.  

 
Left Justify  

1. Highlight the first paragraph you typed, beginning with "We will 
use" and ending with "within a paragraph."  

2. Click on Format.  
3. Highlight Paragraph.  Click on this or press Enter.  
4. Click on the Indents and Spacing tab, if that tab is not in the front.  
5. Click to open the Alignment pull-down menu.  
6. Click on Left.  
7. Click on OK.  
8. The paragraph should now be left-aligned.  
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Alternate Method -- Right Justify by Using Keys  

1. Highlight the text.  
2. Press Ctrl-r.  
3. The paragraph should now be right-aligned.  

Alternate Method -- Left Justify by Using Keys  

1. Highlight the text.  
2. Press Ctrl-l.  
3. The paragraph should now be left-aligned.  

Alternate Method -- Right Justify by Using the Icon  

1. Highlight the text.  

2. Click on the Align Right icon .  
3. The paragraph should now be right-aligned.  

 
Alternate Method -- Left Justify by Using the Icon  

1. Highlight the text.  

2. Click on the Align Left icon .  
3. The paragraph should now be left-aligned.  

Center - Using the Menu  
 

1. Highlight the first paragraph you typed, beginning with "We will 
use" and ending with "within a paragraph."  

2. Click on Format.  
3. Highlight Paragraph.  Click on this or press Enter.  
4. Click on the Indents and Spacing tab, if that tab is not in the front.  
5. Click to open the Alignment pull-down menu.  
6. Click on Centered.  
7. Click on OK.  

Justify - Using the Menu  
 

1. Highlight the first paragraph you typed, beginning with "We will 
use" and ending with "within a paragraph."  

2. Click on Format.  
3. Highlight Paragraph. Press Enter.  
4. Click on the Indents and Spacing tab, if that tab is not in the front.  
5. Click to open the Alignment pull-down menu.  
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6. Click on Justified.  
7. Click on OK.  

Alternate Method -- Justify and Center by Using Keys  

1. Highlight the text.  
2. Press Ctrl-e. The text should now be centered.  
3. Press Ctrl-j. The text should now be justified.  

Alternate Method -- Justify and Center by Using the Icon  

1. Highlight the text.  

2. Click on the Center icon .  The text should now be centered.  
3. Click on the Justify icon .  The text should now be justified.  

Using The Tab Key 

The default tab setting for Microsoft Word is .5 inches. If you press the Tab key, the 
cursor will move 1/2 inch across the page and an arrow will appear on the screen. The 
arrow is a nonprinting character, so when you print your document the arrow will not 
print.  

Illustration  

1. Press the Tab key a few times. Note how you move across the 
page.  

With word, you can display your document in one of four views: Normal, Outline, Page 
Layout, or Online Layout.  

Normal view  
Normal view is the most often used and shows such formatting as line 
spacing, font, point size, and italics. Multiple-column text is displayed in 
one continuous column.  
Outline view  
Outline view displays the document in outline form. Headings can be 
displayed without the text. A heading can be moved and the 
accompanying text moved with it.  
Page Layout view  
The Page Layout view shows the document as it will look when it is 
printed.  
Online Layout view  
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The Online Layout view optimizes the document for online viewing 
(viewing the document in a browser).  

 
Before moving ahead, check to make sure you are in Normal view:  

1. Point to View on the Menu bar.  
2. Click the left mouse button.  
3. The icon next to Normal should be depressed. If the icon next to 

normal is depressed, press Esc twice to close the menu. If the icon 
next to Normal is not depressed, continue on to the next step.  

4. Highlight Normal.  
5. Press Enter. You should now be in Normal view.  

Other Tools 
 
Spell Check 
Word checks your spelling and grammar as you type.  
Spelling errors display with a red wavy line under the word. Grammar errors display with 
a green wavy line under the error. Word will automatically check for spelling and 
grammar errors as you type unless you turn this feature off.  Spelling errors are noted in 
the document with a red underline. Grammar errors are indicated by a green underline. 
To disable this feature, select Tools|Options from the menu bar and click the Spelling 
and Grammar tab on the dialog box. Uncheck "Check spelling as you type" and 
"Check grammar as you type", and click OK. 

To use the spelling and grammar checker, follow these steps: 

� Select Tools|Spelling and Grammar from the menu bar.  
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The Spelling and Grammar dialog box will notify you of the first mistake in the 
document and misspelled words will be highlighted in red. 

 

� If the word is spelled correctly, click the Ignore button or click the Ignore All 
button if the word appears more than once in the document. 

� If the word is spelled incorrectly, choose one of the suggested spellings in the 
Suggestions box and click the Change button or Change All button to correct all 
occurrences of the word in the document.  If the correct spelling is not suggested, 
enter the correct spelling in the Not In Dictionary box and click the Change 
button.  

� If the word is spelled correctly and will appear in many documents you type (such 
as your name), click the Add button to add the word to the dictionary so it will no 
longer appear as a misspelled word.  

As long as the Check Grammar box is checked in the Spelling and Grammar dialog 
box, Word will check the grammar of the document in addition to the spelling.  If you do 
not want the grammar checked, remove the checkmark from this box.   Otherwise, follow 
these steps for correcting grammar: 

� If Word finds a grammar mistake, it will be shown in the box as the spelling 
errors. The mistake is highlighted in green text. 
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� Several suggestions may be given in the Suggestions box. Select the correction 
that best applies and click Change.  

� If no correction is needed (Word is often wrong more than it is right), click the 
Ignore button.  

Synonyms 
Word 2000 has a new feature for finding synonyms. Simply right-click on the word and 
select Synonyms from the shortcut menu. From the list of suggested words, highlight the 
word you would like to use or click Thesaurus... for more options. 
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Thesaurus 
To use the thesaurus, select Tools|Language|Thesaurus from the menu bar or select it 
from the Synonyms shortcut menu as detailed above. 

 
A list of meanings and synonyms are given on the windows. Double-click on the words 
in the Meanings box or click the Look Up button to view similar words. Double-click 
words in the Replace with Synonym box to view synonyms of those words. Highlight 
the word you would like to add and click the Replace button. 
 
Practice  

1. Type the following exactly as shown. Include all errors.  
Open thr door for Mayrala.  She is a teacher from the town of 
Ridgemont.  

2. Highlight: "Open thr door for Mayrala. She is a teacher from the 
town of Ridgemont."  

3. Press F7 or click on the Spelling icon  on the Standard toolbar.  
4. "The" is misspelled so it is highlighted on the screen and noted in 

the Not in Dictionary box.  
5. Word suggests correct spellings. These suggestions are found in 

the Suggestions box.  
6. To change the word to the correct spelling, make sure "the" is 

highlighted in the Suggestions box.  Click on Change.  
Note: If the word is misspelled in several places in the document, 
click on Change All to correct all misspellings.  

7. The name "Mayrala" is not in the dictionary, but it is correct. Press 
Ignore to leave "Mayrala" in the document with its current 
spelling.   
Note: If a word appears in several places in the document, click on 
Ignore All so you are not prompted to correct the spelling for each 
occurrence.  
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8. "Ridgemont" is not found in the dictionary. If you frequently use a 
word not found in the dictionary, you should add that word to the 
dictionary by pressing the Add button. Word will then recognize 
the word the next time it encounters it. Click on Add.  

9. The following should appear on your screen: "Word finished 
checking the selection.  Do you want to continue checking the 
remainder of the document?"  

10. Click on No.  If you wanted Word to spell-check the entire 
document, you would have clicked on Yes.  

 
Find and Replace  
If you need to find a particular word or piece of text, you can use the Find command.  If 
you want to search the entire document, simply execute the Find command.  If you want 
to limit your search to a selected area, highlight that area and then execute the Find 
command.  
After you have found the word or piece of text you are searching for, you can replace it 
with new text by executing the Replace command.  
 
Find - Using the Menu  

1. Type the following:  
Monica is from Easton. She lives on the east side of town. Her 
daughter attends Eastern High School.  

2. Highlight: "Monica is from Easton. She lives on the east side of 
town. Her daughter attends Eastern High School."  

3. Click on Edit.  
4. Highlight Find. Press Enter.  
5. Type east in the Find What field.  
6. Click on Find Next.  

Note that the "East" in Easton is highlighted.  
7. Click on Find Next.  

Note that "east" is highlighted.  
8. Click on Find Next.  

Note that the "East" in Eastern is highlighted.  
9. Click on Find Next. The following message should appear: "Word 

has finished searching the selection. Do you want to search the 
remainder of the document?"  

10. Click on No.  
11. Click on Cancel.  

Alternate Method -- Find by Using Keys  
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1. Highlight: "Monica is from Easton. She lives on the east side of 
town. Her daughter attends Eastern High School."  

2. Press Ctrl-f.  
3. Follow steps 5 through 11 in the preceding section.  

 
 
Replace - Using the Menu  

1. Highlight "Monica is from Easton. She lives on the east side of 
town. Her daughter attends Eastern High School."  

2. Click on Edit.  
3. Highlight Replace. Press Enter.  
4. Type "east" in the Find What box.  
5. Click on Find Next. Do not replace the "East" in "Easton."  
6. Click on Find Next.  
7. In the Replace With box, type west.  
8. Click on Replace.  
9. The "East" in Eastern is highlighted.  
10. Click on Replace.  
11. The following message will appear: "Word has finished searching 

the selection. Do you want to search the remainder of the 
document?"  

12. Click on No.  
13. Click on Close.  
14. Your text should now read:  

"Monica is from Easton. She lives on the west side of town. Her 
daughter attends Western High School." 

Alternate Method -- Replace by Using Keys  

1. Highlight "Monica is from Easton. She lives on the west side of 
town. Her daughter attends Western High School."  

2. Press Ctrl-h.  
3. Follow steps 4 through 13 in the preceding section, but type East 

in the Replace With box.  

 
 


